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Tas Manager 
 

 
 
Key Points: 
 

• Your Tas Manager contains two main folders: a Tas folder and a Tas Data folder. See the 
directory-tree on the left-hand side above. If you do not see a Tas Data folder, contact 
support@edsltas.com for assistance. 

• The Tas folder contains the main programs in the ‘Applications’ subfolder (including the 
3D Modeller, Building Simulator, Systems), Utilities, Macros, User Guides and Manuals. 
These files are always stored on your local machine. 

• The Tas Data folder contains your project data files, example files, databases and 
templates that are included with the software. These files can be stored anywhere, e.g. 
on a server or a local machine. 

• Registration of license keys takes place here, i.e. through your Tas Manager (click 
Register to open the Registration dialog box). License keys will expire periodically 
(typically after one month). These will be updated automatically from Tas 9.4.4, otherwise 
you will need to update them by sending an email to support@edsltas.com. For further 
details please see the website: http://www.edsltas.com. 

 
 
 
 
 

mailto:support@edsltas.com
mailto:support@edsltas.com
http://www.edsltas.com/
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Starting a New Project: 
 

• Create Project – Allows you to simply add a new project directory to your ‘Data Directory’ 
• Create Building - To begin a new project click ‘Create Building’, you will then be 

presented with the option to use templates. The below exercise continues without using a 
template. However, if you do have a template available you can use that in the future. 

• Create Report – Will allow you to automatically generate reports from your Tas files, there 
are options to integrate your own logo files to personalize the reports: 

 
• Templates - The use of a templates allows some automatic assignment of building input 

data, such as: 
o Internal heat gains, thermostat set points, dynamic functions, and schedules 

(internal Conditions) 
o Building fabric data, e.g building envelope constructions, built up material layer 

by layer (Constructions) 
o Calendar, for day type specification 
o Also opens your 3D modeller file with ‘Zone Sets’ predefined based on the 

‘Internal Conditions’ found in the template to allow for easier allocation of thermal 
zones in the model 

 
 
 
Exercise:  
 

1) Open the Tas Manager 
2) Click on the Create Building button. 
3) Call the building: Training 3D_’user_name’ 
4) Check the create new project directory box  
5) Click the Next button. 
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Templates 
 

 
 

 
Key Points: 
 

• Templates contain default constructions, internal conditions and a calendar. Zone sets 
will be generated based on the name of the internal conditions in the 3D Modeller file. 

  
Exercise:  
 

1) Use the training template.tbt template found in the data folder provided. 
2) Click on the Next button. 

 

Sawford, Michael
Training template.tbt referenced in screen capture but B1 Office… referenced below?
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Weather 
 

 
 

Key Points: 
 

• USA weather data is included with Tas, the data is obtained from the US government 
EnergyPlus website listed below. 

• Weather data for locations across the world can be obtained from the Department of 
Energy’s website for EnergyPlus, including many Canadian weather locations: 
https://energyplus.net/weather  

• Another source of weather data is the program called Meteonorm: 
http://meteonorm.com/ 

• Data obtained from Meteonorm or from the EnergyPlus website will be in the EPW or 
TMY2 format which can be converted into Tas format by opening the Tas Weather 
database application and selecting “Import Weather Data”. 

• Once converted the data can be re-used on any project file. Tas allows users to create 
their own databases of data including for weather. 

• The 3D model that is generated through the process will have its latitude, longitude and 
time zone set by the selected weather data. 

 
Exercise:  
 

1) Open the USA weather data database found in “…\Tas Data\Databases\USA tmy2.twd”. 
2) Choose the New York – Central Park weather data 
3) Click on the Finish button. 

https://energyplus.net/weather
http://meteonorm.com/
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Building 
 

 
 
Key points: 
 

• The orientation of the north angle (see North Angle in the ‘Building’ dialog box) can be 
altered at any time, even after the building has been drawn and the geometry has been 
exported to the Building Simulator. 

• The Latitude, Longitude and Time Zone parameters are used for the shadow calculations 
performed in the Tas 3D Modeller application. These values displayed here have been 
read from the weather file and altering them is not recommended. 

• There is no auto-save or file recovery option in Tas, so you should save your work often. 
You can also use CTRL+S to save. 

 
Exercise:  
 

1) Open the Building dialog box  
2) Change the north angle to 10 degrees, clockwise from north. 
3) Close the Building dialog box and save the model. 
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Storeys/Floors 
 

 

 
 
Key Points: 
 

• Storeys/Floors can be added or removed at any stage in the development process.  
• Removing a floor does not mean that other floor levels will change to accommodate the 

removal of the floor. 
• The floor level is measured from the ground plane at datum 0.0m, not from sea level. 

Two or more floors can have the same level. 
• A floor level can be negative, for example when modelling basements or underground 

carparks. 
• The Default Wall Height dimension is measured from below the floor finish (e.g. below the 

carpet or tiles) to directly below the floor finish of the upper floor. If a constant value is 
assumed for the thickness of the finish it means that the default wall height can be 
thought as the floor-to-floor height. 

• The “New Above” button generates a floor directly above the selected floor. 
• The “Ground Floor” checkbox sets the default floor building element to “Ground Floor”. 

This should be done for floors that touch the ground. 
• The “Create” button will open the “Copy New Floor” dialog box for copying walls between 

floors. 
 
Exercise:  
 

1) Open the Storeys dialog box. 
2) Change the default wall height of the ground floor to 11ft.  
3) Create a new floor called First Floor. Set Default Wall Height to 11ft. The level should be 

set so that First Floor sits directly above Ground Floor. 
4) Create a new floor called Panel. Its default wall height is 11ft. The floor level should be 

such that Panel sits directly above First Floor. 
5) Close the Storeys dialog box and save the model. 
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Drawing Walls 
 

 
 
Key Points: 
 

• Right clicking when drawing a wall, brings up a pop menu which includes options for 
setting the length, turning angle snap on/off etc. 

• When drawing walls, keep Angle Snap on when possible. 
•  “Wall Centre” is the recommended wall alignment type. 
• <Null> walls are non-physical dividing lines (or ‘construction lines’) used to partition and 

bound spaces that differ, for example: by zone, floor, ceiling construction, or slope... 
• Tas cannot draw curved surfaces. You can approximate curves as a set of straight lines. 

A heuristic method of drawing a circle is to draw a 16 sided shape. 
 
Exercise: 
 

1) Draw a wall. Set the length of the wall to 32 feet. 
2) Save the model. 
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Import Drawing 
 

 
 
Key Points: 
 

• Before importing a 2D DWG or DXF, the user should open the file in a CAD package and 
a draw a 32ft line. This line will be used to set the scale in the 3D Modeller. You should 
also draw an unconnected 32 foot line in 3D Modeller. 

• If the building has multiple DWGs, draw the line in the same place on each drawing. This 
is important to ensure the correct positioning of the DWG with respect to the model. 

• While the DWG is open in the CAD package, select everything and copy to a new DWG 
to ensure the drawing is near the origin.  

• Select everything in the DWG and then choose to explode or ungroup. 
• If the DWG was not drawn on the XY plane, then use a rotate tool and save it on the XY 

plane. 
• Remove any unnecessary layers, select the purge option and then save the file. 
• To import a DWG after the model has been partially drawn requires the user to map the 

DWG to the existing model. This involves first selecting a point on the DWG and then 
selecting the identical point on what has already been drawn.  
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Exercise: 
1) Click on the Import Drawing button as found in the Drawings tab. 
2) Import the drawing file “Training Ground Floor.dwg”. This file can be found data folder 

provided. 
3) Drag the drawing tab towards the right-hand side to create a side-by-side as shown in the 

screenshot. 
4) Set the drawing scale by clicking ‘Input two points’ and clicking both endpoints of 32ft line 

on the drawing and entering the ‘Distance between points’ as 32ft. 
5) Map the drawing to the existing 32ft wall by clicking ‘Input drawing and model points’, 

selecting one end of the 32ft line on the drawing and then the corresponding end of the 
32ft wall drawn in the Plan View. 

6) Close the Import Drawings dialog box. 
7) Display the drawing in the ground floor plan view. Change the display colour of the 

drawing to a bright green. 
8) Save the model. 
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Drawing around the template 
 

 
 
Key Points: 
 

• There is an option to snap to drawing but is generally recommended that the option is not 
used. 

 
Exercise: 
 

1) Select <default>  from the Elements 
2) Draw the walls using the DWG file as a template.  
3) Save the model. 
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Null Element 
 

 
 
Key Points: 
 

• The <Null> Building Element is a super-transparent construction that allows air/solar/light 
to go through it. 

• When it is used as a wall, it is sometimes called a construction line. 
• A space has one floor element, one ceiling element, up to one zone and one floor plane 

and one ceiling plane.  
• If a room has multiple floor\ceiling element or planes or contains multiple zones, the room 

needs to be divided into multiple spaces.  
• <Null> walls are used to divide rooms into multiple spaces.  

 
Exercise: 
 

1) Select <Null> from the Elements list. 
2) Click on the Set Wall Element button. 
3) Click on the 3 walls highlighted in the above drawing to change them into <Null> walls. 
4) Save the model. 
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3D View 
 

 
 
Key Points: 
 

• The “New 2D Plan Window” and “New 3D Window” windows are used to generate 
additional views of the model. They are not used to return to an existing view. To do that, 
select an existing window from the Window menu or one of the open tabs. 

• Fit All, Zoom In, Zoom Out and Pan are tools that can all be actioned with the mouse 
wheel. 

• The Arrow keys on your keyboard can be used to walk around the inside of the model on 
a 3D window.  

• Click Right-Shift on your keyboard to increase movement speed. Do not hold down the 
Right- Shift key as it will increase the speed excessively. 

• Click the Backspace key to reduce movement speed. Again, do not hold down the 
Backspace key as it will decrease the speed excessively. 
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Creating Building Elements 
 

 
 
Key Points: 
 

• The building element width is the thickness of the surface that affects the volume of the 
room. For example, the floor surface on the ground floor may be 1ft thick but the carpet is 
only 2in thick. The ground floor thickness in this table is 2in. 

• The component width entered in this table does not affect the thermal mass or any 
thermo-physical property of the building element itself. It is the construction applied to the 
building element within the Tas Building Simulator module that affects these properties. 
This means the construction and building element widths do not have to match. 

• By enabling the Ground checkbox and if this building element is exposed, then the 
external surface will be modelled as touching the ground. If the building element is used 
internally, then the Ground checkbox will have no effect on the results. 

• The Transparent checkbox is for visualization only (Daylighting calculations are not 
covered in this training module). It is the construction applied to the building element 
within the Building Simulator module that determines if the surface is opaque or 
transparent. 

• The Internal Shadows checkbox, if enabled, allows shadows to fall within the zone rather 
than on the transparent building element. It is recommended that this option is selected 
for transparent elements that are exposed to the outside (and required if performing 
daylighting calculations). 

• The internal shadows option has no effect if applied to internal building elements. 
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Exercise: 
 

1) Open the Building Elements dialog box. 
2) Update the Building Element width to match the table above. 
3) Create new building elements, as shown above. Change their widths to 0.04in and 

colors to match the table (the colors do not have to match exactly but the widths 
should do. Unit display settings can be altered in the Tas Manager > Settings 
dialogue). The new building elements are: 

 
• Panel Sunside 
• Panel Underside 
 

4) Ground Floor, Internal Floor, Exposed Floor and Panel Underside should all 
include sloping surfaces in the floor area calculations. 
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Building Element Types 
 

 
 
Key Points: 
 

• Building Elements can have a Type assigned to them. This will then determine a template 
construction to be automatically assigned when the analysis model is generated. 

• Constructions can be modified by the user at a later stage in the modelling process and 
you do not need to assign a type to all Building Elements. 

• Window and shade types are assigned automatically. Window components are 
designated as ‘Frame’ and one of ‘Glazing’, ‘Door’ or ‘Rooflight’. Opaque rooflights 
become ‘Solar/PV Panel’. 

 
Exercise(Optional): 
 

1) At the bottom of the Building Elements dialog box, ensure that the Building Element 
Types checkbox is enabled. 

2) Set up the Types to match those shown in the screenshot. 
3) Close the Building Elements dialog box and save the model. 
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Assigning Building Elements to Surfaces 
 

 
 

Key Points: 
 

• When the <Default> building element is used, “External Wall” is applied to walls exposed 
to the outside and “Internal Wall” is applied to walls where neither surface is exposed. 
Similarly, floors will become Internal Floor/Exposed Floor and ceilings will become 
Internal Ceiling/Roof. 

• This will be made explicit after exporting your geometry to the Building Simulator. 
• When <Null> is applied to a ceiling or floor surface, the surface itself is removed from the 

space.  
• Walls, floor and ceiling elements can be changed within the 3D view. 
• When using the set building element option, one side of the wall is highlighted in red.  

The red line is the outside layer. If it is on the wrong side, right-click on the element and 
choose the Reverse Element option. 

• Building elements can be applied to walls in three ways: 
o ‘Select’ a wall, right-click and edit the ‘Properties’ 
o ‘Select’ a wall, right-click and ‘Set Building Element’ to whichever building 

element is selected in the Elements list 
o Choose a Building Element from the Elements list first and then use the ‘Set Wall 

Element’ tool to apply it to the wall with a single click 
• Building elements can be applied to ceiling and floors in three ways: 

o ‘Select a space, right-click and edit the ‘Properties’. 
o Select a space right-click and edit and ‘Set Ceiling Element’ or ‘Set Floor 

Element’ to whichever element is selected in the Elements list. 
o Choose a Building Element from the Elements list first and the use the ‘Set 

Ceiling Element’ or ‘Set Floor Element’ tool to apply to the space with a single 
click 

 
Exercise: 
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1) Assign External Wall to the walls that have a red line in the above picture. 
2) Ensure that the red line for those walls is facing the eastern room (as pictured). 
3) Set the ceiling of the circled space to <null>. 
4) Save the model. 
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Windows and Doors 
 

 
 
Key Points: 
 

• Adding windows are a method of placing a building component within the area of an 
existing element. (Usually a glass pane and frame within a wall.) A window does not have 
to be transparent or even glass. (For example, a window can be used to model a louvre.) 

• If two windows have different constructions, aperture, blind controls, or feature shading, 
then they must be different window types. 

• Window and door dimensions must allow them to fit within the wall intended to house the 
components. The level must be greater than or equal to the floor surface width of the 
adjacent zone and the sum of the window level and height must be less than or equal to 
the difference between the wall height and ceiling surface width of the adjacent zone. The 
window cannot overlap any of these widths. 

• The placement type “Door” means that the level is set to be slightly greater than the floor 
surface width. (An offset of 1mm will be used.) 

• The placement type “Full Wall Height” will set the level to be equal to the floor surface 
width and the sum of the window level and height to equal the difference between the 
wall height and ceiling surface width. 

• The window colour is used in both the 2D and 3D views. 
• Roof window width represents its length in the x-direction. 
• Roof window height is in the y-direction. 

 
Exercise: 
 

1) Open the Windows dialog box. 
2) Enable the Window Dimensions and Frame Dimensions checkboxes to display the 

respective columns on the Windows dialog box. 
3) Create the four windows and 1 door, as shown above. 
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Window Groups 
 

 
 
Key Points: 
 

• Creating window groups defines a method of placing multiple windows or doors onto a 
model efficiently. 

• To model a window positioned directly above another on the same floor level, a window 
group must be used. 

• They can contain both windows and doors. 
• They can contain other groups. 
• They can contain both windows and doors that are not in contact with each other. 
• Roof windows cannot be placed on the same group as wall or doors placement types. 

 
Exercise: 

 
1) Create a window group called Four Window Group it should contain two lower windows 

and two upper windows. The lower windows should be side-by-side as should the upper 
windows. 

2) Close the Windows dialog box and save the model. 
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Adding Windows to Models 
 

 
 
Key Points: 
 

• Windows can be added, moved and deleted from a 2D Floors window. 
• Windows can be stretched so that their width is as long as the wall they are applied to is. 

This is called “fit to wall”. 
• Windows can be edited locally in a 2D plan view and existing windows can be replaced 

using the Set Window button on the toolbar, within a 3D Floors view. 
 
Exercise: 
 

1) Add the Four window group to the walls. They are blue. 
2) Add 4 doors to the model. They are purple. 
3) Add 2 Curtain walls to the model. They are highlighted in red in the above picture.  
4) Set the curtain walls to fit to wall. 
5) Save the model. 
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Creating Shades 
 

 
 
Key Points: 
 

• Modelling external shades in a 3D model takes into account both direct and diffuse 
shading. (This is true also of Feature Shades which are set up numerically in the Building 
Simulator.) 

• A shade configuration can be either “Vertical” or “Roof” and contain both horizontal and 
vertical shade elements, such as fins or slats. 

• The shade elements can be rotated around their axis and from the frame. 
• Horizontal fins, vertical fins, the left and right frame edges and the top and bottom frame 

edges can be made of different constructions. 
• Shades follow the same rules regarding level and height as windows. 
• Shade groups follow the same rules as window groups. 

 
Exercise: 
 

1) Open the Shades dialog box. 
2) Create a grey vertical shade called Shades. 
3) The shades should cover an area of 6ft 6in wide by 11ft high and should be at the floor 

height. 
4) The shade has 16 horizontal fins. These fins are 8in deep. The fins are horizontal and 

have not been rotated. 
5) The frame has a top and bottom edge and a left and right edge. The width is 2in and its 

depth is 4in. 
6) Close the Shades dialog box and save the model. 
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Adding Shades to the Model 
 

 
 
Key Points: 

• Shades cannot be applied directly to the walls. They must be applied to a <Null> wall, 
which forms part of an external area connected to the building. 

• This space is bounded by <Null> walls on its exposed surfaces. Its ceiling and floor 
surface are set to <Null> in order to remove them. 

• The space should be assigned an external zone. 
 
Exercise: 
 

1) Using <null> walls, draw the space south of the curtain wall as shown in the drawing 
above. The short walls are 1ft long and the long wall is as long as the curtain wall. 

2) Assign <null> to the ceiling and floor of that space. 
3) Add a shade to the long <null> wall, fit it to the wall. 
4) Save the model 
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Displaying Drawing Errors 
 

 
 

Key Points: 
 

• The user can quickly validate a 2D floor plan by displaying any errors or warnings before 
further developing a model. On the View menu, click Display Errors. The dialog box 
shown above will open.  

• Errors at this stage will prevent the model being displayed in a 3D Zones view and thus 
prevent the geometry being exported to the Building Simulator. For example, overlapping 
walls will cause an error. 

• If a wall is less than 8in long, this can cause a warning. This is because 8in is the 
minimum snap distance. The user will still be able to export the model to the Building 
Simulator and the 3D Zones view will still properly display the model but the user may 
encounter issues when drawing walls near to the short walls and they might not correctly 
copy from one floor to another. 

• If a wall causes an error or warning, its endpoints will be circled in black. 
• The error check will not look at any other issue such as windows overlapping walls or 

intersecting spaces. 
 
Exercise: 
 

1) With a 2D Plan view active choose Display Errors from the View menu and then click 
Yes to display both errors and warnings. 

2) Fix any problems that occur and re-check for errors. 
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Copying Floors 
 

 
 
Key Points: 
 

• The Create New Floor dialog box opens when an empty floor is selected from the Floors 
drop-down menu on the right-hand side of the main application window. It will not appear 
if something has already been drawn on that floor. 

• When the “Copy all walls…” checkbox is enabled, the software will copy all walls, 
windows and shades from the floor selected in the dialog box. 

• It will not copy the user-set floor or ceiling elements such as <Null> or Roof, the floor or 
ceiling height information or zones. It will use defaults instead. 

• If “Copy perimeter walls with offset” is selected, the software will extend the perimeter 
walls by the distance set in the “Overhang offset” textbox and windows or shades will not 
be copied. 

• A negative value can be entered in the “Overhang offset” field when copying perimeter 
walls. This will reduce the dimensions of the new floor with respect to the original floor. 

• There are also options to copy a selection of walls, windows and shades after the initial 
floor has been drawn. (For example, “Copy to input floor”.) 

 
Exercise: 
 

1) Select the First Floor in the 2D Plan Filter sidebar. This should open the Create New 
Floor dialog box. 

2) Copy all walls from the Ground Floor to First Floor. 
3) Save the model. 
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Import Drawings (Part 2) 
 

 
 
Exercise: 
 

1) Import the “Training First Floor.dwg”. This file can be found in the data folder provided. 
2) Drag the drawing tab towards the right-hand side to create a side-by-side as shown in the 

screenshot. 
3) Set the drawing scale by clicking both endpoints of 32ft line on the drawing and entering 

the Distance between points as 32ft. 
4) Map the drawing to the existing 32ft <null> wall by clicking ‘Input drawing and model 

points’, selecting one end of the 32ft line on the drawing and then the corresponding point 
on the First Floor plan view. 

5) Display the drawing (in green) on the First Floor.  
6) Save the model. 
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Drawing the First Floor  
 

 
 

Exercise: 
 

All the following changes should be made to the first floor only: 
 
1) Delete all the walls of the northern building. Delete the <Null> walls of the external shade 

space. 
2) Delete the southern curtain wall and add two of the Four Window Group in its place. 
3) Delete the other curtain wall. 
4) Delete all the doors. 
5) Delete the shade and corresponding Null walls 
6) Connect the top and bottom of the east and west buildings with <Default> walls. 
7) Add two <Default> horizontal walls then delete two vertical walls in the area circled in the 

above picture.  
8) In the space in red hatching in the above picture, set the floor to <Null>. 
9) Add a skylight in the hatched space. 
10) Save the model. 
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Setting Heights for Ceilings 
 

 
 
Key Points: 
 

• Ceiling and Floor heights can be set for points, walls, and spaces. 
• Heights can be set to the default value for the floor level; a user defined value or 

calculated using a plane. 
• Ceiling heights default to the default value for the floor level, Floor heights default 0 

metres above the height of the current floor. 
• If the height of a wall or point is changed, Tas will slope the adjacent spaces accordingly.  
• Tas can only create Euclidean planes, so if changing the height of a point or wall causes 

a non-Euclidean plane to be created, that surface will not appear in the 3D model and will 
generate a warning when exporting the model or viewing in analysis mode. 

 
Exercise: 
 
1) Select the plan view- Ground Floor tab 
2) On the ground floor: 

 
a. Set the ceiling height of the north and south wall of the northern building to 26ft 

3in. 
b. Set the ceiling height of the central <Null> wall of the southern building to 32ft 

10in. 
2) Save the model. 
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 Snapping to the drawing 
 

 
 
Exercise: 
 

1) In the 2D Plan Filter, select Panel and click Cancel on the subsequent dialog box. This 
should create a new 2D Plan View of the Panel floor without copying any existing walls 
from the Ground Floor or First Floor. 

2) Import the “Training Panel Level.dwg”. This file can be found in your “\Tas Data\Training 
Files” directory. 

3) Set the drawing scale in the same way as with the previous drawings and map to the 32ft 
line on either the Ground Floor or First Floor. 

4) Display the DWG on the Panel floor to use as a template for tracing. 
5) Turn Angle Snap OFF and turn Snap to Drawing ON. 
6) Use the Panel Underside building element to draw all four sides of the panel. 
7) Set the floor to Panel Underside and set the ceiling to Panel Sunside. 
8) Turn Angle Snap ON and turn Snap to Drawing OFF. 
9) Save the model. 
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Sloping Floors 
 

 
 

 
 

 
Key points: 
 

• There are three ways of creating planes in the 3D Modeller: by selecting three points on 
an existing space; by selecting a wall and setting the inclination or by using offsetting 
from another plane. 

• Once the plane is generated it can be applied in order to set the height of a ceiling or 
floor surface.  If the plane is redefined or deleted, then the height of the ceiling or floor 
surface to which it was originally applied does not change. 

• Planes cannot be used to directly slope walls. To model a sloped wall, apply a plane to a 
ceiling or floor surface then apply a suitable wall element. 

• Planes are infinite in scope and can be applied to levels other than from the one it was 
generated. 

• Tas models Euclidean planes and not curved surfaces. For curved roofs, facet the roof 
using <Null> walls. 
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Exercise: 
 
1) Select 3 corners of the panel, the two southern points and the south-western point. The 

order you select them determines which point is called A, B and C. 
2) Use Tools -> New 3D Plane -> By points... to create Underside Plane. This 3D plane 

should pass through the southern points (A and B in the diagram) at a height of 0ft and the 
south-western point (C) at a height of 3ft 4in.  

3) Use Tools -> New 3D Plane -> Offset... to create Sunside Plane. This plane should be 
offset by 2in from the original Underside Plane. 

4) Select the panel space and modify its height as follows: 
a. The ceiling height should follow the Sunside Plane. 
b. The floor height should follow the Underside Plane. 

5) Save the model. 

 



TAS Building Designer Training Course 

 - 32 - 

Zones and Zone Sets 
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Key Points: 
 

• The zoning process should create a set of zones which are distinguished from all others 
in contact with it by differences in one or more of the following: 

a. The Activity (Internal Condition) applied to it. 
i. The lighting system which serves it. 

b. The HVAC system which serves it. 
c. The access to daylight (through windows and rooflights). 
 

• To create these zones: 
a. Divide the floor plates into separate areas bounded by structural walls or other 

permanent elements. 
b. If any part of the area is serviced by a significantly different HVAC or lighting 

system, separate those areas using “Null” walls. 
c. Use “Null” walls to create spaces that are bounded by fenestration with a similar 

glazing ratio, light transmittance and orientation. This means that where there is a 
benefit from daylight linked controls (manual or automatic) a given lighting zone 
should not extend beyond 20 feet from the perimeter. 

• Do not set the same zone for two spaces that are not contiguous. 
o Never use the same zone in two spaces, creates cross-ventilation where it 

should not exist. 
• A space can be sub-divided vertically into different zones. These zones will have to 

appear on different floor plans. 
• If buildings have been drawn on a model for shading purposes, then those areas do not 

need to be zoned. They will still shade the zoned areas. 
• If a wall of a zoned area is in contact with an unzoned area, it is modelled as being 

adiabatic (e.g. no heat loss to unzoned areas). 
• When using templates, Internal conditions are applied to zones based on the zone set 

name so do not alter those names. 
 
Exercise: 
 

1) Open the Zones dialog box. 
2) Delete the default zone set called "Zone" (contains 20 zones). 
3) Add zones to the other zone sets according to the following table. Set the zone colours in 

each set to be a variation of the colour indicated in the table.  
 

Zone Sets No. of Zones Colour 
Office 17 Red 
Circulation 4 Green 
Store 1 Yellow 
Toilet 2 Blue 
Unoccupied and Unconditioned 2 Purple 

 
4) Rename the 2 zones in Unoccupied and Unconditioned to SHW Panel and External. 
5) Set External to be an external zone. 
6) Close the Zones dialog box and save the model. 
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Adding a perimeter line 
 

 
 
Exercise: 
 

1) On the first floor, draw the <Null> walls shown in red in the above picture. The vertical 
<Null> should be 20ft from the western wall. The horizontal <Null> walls should be 
drawn as continuations of the respective, nearby short <Default> walls. 

2) Select all of the newly drawn <Null> walls and copy them to the ground floor  
3) Save the model. 
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Assigning Zones to Spaces 
 
 
 
 
 
 

Ground Floor 
 

 
 

First Floor 
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Panel 

 
 
Key Points: 
 

• Zones can be set in both a 2D and 3D floor view. 
• Zone colours only appear in the 2D view when the “Set Zone” button on 

the toolbar is depressed. 
• Holding the 'Alt' key while applying a new zone will automatically select (or 

create) the next zone in the zone set. 
• To unzone a space, select the <None> option from the Zones drop-down 

list on the right-hand side of the main application window and apply it to 
the space. 

• The font size for the zone names can be altered 
 
Exercise: 
 

1) Display zones by their colours and names.  
2) Zone the model as per the screen shots. Note that Circulation 3 is used 

on both the ground floor and the first floor. 
3) Save the model. 
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3D Analysis 
 

 
 
Key Points: 
 

• Switching to the Analysis view carries out the same error checking as exporting the 
model. 

• If any errors or warnings are found, a dialog box will open. 
• Errors are problems that prevent the model from being generated. 
• Warnings are problems that do not prevent the 3D Modeller from generating the building, 

but which may have an impact on your results. 
• When checking errors and warnings, you must check all warnings and determine their 

effect on your results. If the effect is likely to be significant, then amend the geometry to 
remove the warning. Do NOT ignore warnings! 

• Errors and warnings can be checked at any time. It is recommended that you check for 
errors and warnings through out the entire creation process and not just at the end. 

• If you update your geometry, then the 3D Analysis view will not automatically be updated. 
You must refresh the view with Ctrl+R or the Refresh button. 

 
Exercise: 
 

1) Display the 3D model and enable Analysis Mode. if any errors or warnings are found, 
amend the model and refresh the analysis view. 

2) Display shadows for day 93, hour 14. 
3) Open the zone dialog box and purge unused zones 
4) Save the model. 
5) Close the model. 
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